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Bid Number 50 - 00118737

A ONE-TIME PURCHASE OF PLUMBING HAND TOOLS, CURB STOP AND
VALVE KEYS FOR THE JEFFERSON PARISH PUBLIC WORKS WAREHOUSE

BID DUE: January 25, 2017 / 11:00 AM

ATTENTION VENDORS!!!

Please review all pages and respond accordingly, complying with all provisions
in the technical specifications and Jefferson Parish Instructions for Bidders and
General Terms and Conditions. All bids must be received in the Purchasing
Department by the bid due date and time.

Jefferson Parish Purchasing Department
200 Derbigny Street
General Government Building, Suite 4400
Gretna, LA 70053
Buyer: Melissa Ovalle
Buyer Email: movalle@jeffparish.net
Buyer Phone #: 504-364-2687




JEFFERSON PARISH

Department of Purchasing

Michael S. Yenni Brenda J. Campos
Parish President Director

CHANGES TO JEFFERSON PARISH BIDDING PROCEDURES

The East bank Office of Purchasing is now open! We are located in the Joseph S. Yenni
Building, 1221 Elmwood Park Blvd,, Suite 404, Jefferson, LA 70123. Bidders may submit
bid responses at this location, pending authorization in each bid package. Bidders should
carefully read and must respond accordingly per the requirements of the bid
packages. NOTE: Bidders submitting bids on the day of bid opening, bidders must
submit at the West Bank location only.

Other Changes Continued:

e Effective June 1, 2017, bidders may no longer send bid responses via facsimile, as
some bid solicitations may provide. Vendors responding to bid solicitations may
only submit via USPS, courier service, hand delivery or via online by registering free
of charge at www.jeffparishbids.net. For more information, please contact the
Purchasing Department or visit jeffparish.net.

o Affidavits (Non-Public Works Affidavit or Public Works Affidavit) - as you are

aware, bidders are required to submit affidavits pursuant to LA public bid law and
Jefferson Parish Code of Ordinances. Bidders must read each bid package to ensure
compliance. Effective August 1, 2016, affidavits are required with bid submission.
While copies are acceptable to include with bid submission, original affidavits are
required upon contract execution. Original affidavits are encouraged with bid
submission.

e Current W9 Forms and vendor applications may be submitted at any time; however,
if your company is not registered and/or a current W-9 form is not on file, a current
W-9 form must be supplied upon contract execution, should you be awarded a
contract and/or issued a purchase order.

e Upon contract execution, successful bidder must continue producing final insurance
certificates per standard Jefferson Parish insurance requirements. Proof of
insurance is required for bidding purposes. Bidders must read the insurance
requirements attachment included in each bid package for specific instructions.

Bidders should reference the “Additional Requirements” section of the bid
instructions and/or the “Important Notice to Bidders” included in the bid package
for specific requirements to respond accordingly.

For more information, please call Jefferson Parish Purchasing at 504-364-2678.

General Government Bidg. — 200 Derbigny St —~ Suite 4400 - Gretna, LA 70053
Office 504.364.2678 ~ Fax 504.364.2693
Emall: Purchasing@ieffparish.net Website: www.jeffparish.net




INVITATION TO BID Page: 1

DATE:  1118/2017 THIS IS NOT AN ORDER
.+ 50-00118737
BIDNO JEFFERSON PARISH
PURCHASING DEPARTMENT
P.0. BOX 9

GRETNA, LA. 70054-0009
504-364-2678

VENDOR: 27118 BLANK BID COPY VENDOR _ Coburn's BUYER: MOVALLE

Bids will be received until 11:00 AM, 1/25/2017 via fax: 504-364-2693 or via online at www.jeffparishbids.net.

This site is free for all Jefferson Parish vendors. For additional information on registration or use of this free site,
please see the text box highlighting electronic procurement.

All bids submitted are subject to these instructions and general conditions and any special conditions and specifications contained
herein, all of which are made part of this bid proposal reference. By submitting a bid, vendor agrees to comply with all

provisions of Louisiana Law, as well be in compliance with the Jefferson Parish Code of Ordinances, Louisiana Coede of

Ethics, applicable Jefferson Parish ethical standards and Jefferson Parish Resolution No. 113646 and/or Resolution

No. 113647. A copy of these resolutions may be obtained from the Office of the Parish Clerk, Suite 6700,

Jefferson Parish General Government Building, 200 Derbigny Street, Gretna, LA 70053, You may also obtain a copy by visiting the
Purchasing Depariment webpage at purchasing.jeffparish.net and clicking on On-line forms,

All vendors submitting bids should register as a Jefferson Parish vendor if not already yet registered. Registration forms may be
downloaded from http://purchasing.jeffparish.net and by clicking on Vendor Information. Current W-9 forms with respective Tax
Identification numbers and vendor applications may be submitted at any time; however, if your company is not registered and/or

a current W-9 form is not on file, vendor registration is mandatory. Further, a current W-9 form and respective Tax Identification
number must be supplied upon contract execution, should you be awarded a contract and/or issued purchase order. Failure to do
so may result in delay of payment.

As per LSA-RS 47:301 et seq., all governmental bodies are excluded from payment of sales taxes to any Louisiana taxing body.
Quotations shall be based on F.O.B. Delivered, anywhere within the Parish as designated by the Purchasing Department.
JEFFERSON PARISH WILL ACCEPT ONE BID ONLY FROM EACH VENDOR,. Items bid must meet specifications. JEFFERSON
PARISH will accept one price for each item unless otherwise indicated. Two or more prices for one item will result in bid rejection.
Bidders are required to complete, sign and return the bid form and/or complete and return the associated line item pricing forms as
inhdiﬁated. Xhe price quoted for work shall be stated in figures. In the event there is a difference in unit prices and totals, the unit prices
shall prevail.

JEFFERSON PARISH reserves the right to award contracts or place orders on a lump sum or individual item basis, or such
combination, as'shall in its judgment be in the best interest of JEFFERSON PARISH. Every contract or order shall be awarded to the
LOWEST RESPONSIVE and RESPONSIBLE BIDDER, taking into consideration the CONFORMITY WITH THE SPECIFICATIONS and
the DELIVERY AND/OR COMPLETION BATE

JEFFERSON PARISH reserves the right to cancel all or any part of an order if not shipped promptly. No charges will be allowed for
parking or cartage unless specified in the quotation. The order must not be filled at a higher price than quoted. JEFFERSON PARISH
reserves the right to cancel at any time and for any reason by issuing a THIRTY (30) day written notice to the contractor.

JEFFERSON PARISH requires all products to be new (current) and all work must be performed according to standard practices for the
project. Unless otherwise specified, no aftermarket parts will be accepted. Unless otherwise specified, all workmanship and materials
must have at least one (1) year guaranty, in writing, from the date of delivery and/or acceptance of the project.  Any deviations or
alterations from the specifications must be indicated and/or supporting documentation supplied with bid submission.

If this bid requires a pre-bid conference (see Additional Requirements section), bidders are advised that such conference will be held to
allow bidders the opportunity to identify any discrepancies in the bid specifications and seek further clarification regarding instructions.
The Purchasing Department will issue a written response to bidders’ questions in the form of an Addendurm.

All formal Addenda require written acknowledgment on the bid form by the bidder. Failure to acknowledge an Addendum on the bid
Logm shall cause the bid to be rejected; JEFFERSON PARISH reserves the right to award bid o next lowest responsive and responsible
idder in this event.

USE OF BRAND NAMES AND STOCK NUMBERS: Where brand names and stock numbers are specified, it is for the purpose of
establishing certain minimum standards of quality. Bids may be submitted for products of equal quality, provided brand names and
stock numbers are specified. Complete product data may be required prior to award.

Quantities listed are for bidding purposes only. Actual requirements may be more or less than quantities listed.

Bidders are not to exclude from participation in, deny the benefits of, or subject to discrimination under any program or activity, any
person in the United States on the grounds of race, color, national origin, or sex; nor discriminate on the basis of age under the Age
Discrimination Act of 1975, or with respect to an otherwise qualified handicapped individual as provided in Section 504 of the
Rehabilitation Act of 1973, or on the basis of religion, except that any exemption from such prohibition against discrimination on the
basis of religion as provided in the Civil Rights Act of 1964, or Title Vi and VI of the Act of April 11, 1968, shall also apply. This
assurance includes compliance with the administrative requirements of the Revenue Sharing final handicapped discrimination
provisions contained in Section 51.55 (c), (d), (e), and (k)}{5) of the Regulations. New construction or renovation projects must comply
with Section 504 of the 1973 Rehabilitation Act, as amended, in accordance with the American National Standard Institute’s
specifications (ANSI Al 17.1-1961).




DATE:  1/19/2017

BID NO.: 50-00118737 Page: 2

INSTRUCTIONS FOR BIDDERS AND GENERAL CONDITIONS

IN ACCORDANCE WITH STATE REGULATIONS JEFFERSON PARISH OFFERS ELECTRONIC PROCUREMENT
- TO ALL VENDORS

This electronic procurement system allows vendors the convenience of reviewing and submitting bids online.
This is a secure site and authorized personnel have limited read access only. Bidders are encouraged to
submit electronically using this free service; while the website accepts various file types, one single PDF file
containing all appropriate and required bid documents is preferred. Bidders submitting uploaded images of
bid responses are solely responsible for clarity. If uploaded images/documents are not legible, then bidder’s
submission will be rejected. Please note all requirements contained in this bid package for electronic bid
submission.

Please visit our E-Procurement Page at www.jeffparishbids.net to register and view Jefferson Parish
solicitations. For more information, please visit the Purchasing Department page at
http:/ipurchasing.jeffparish.net.

ADDITIONAL REQUIREMENTS FOR THIS BID

PLEASE MATCH THE NUMBERS PRINTED IN THIS BOX WITH THE
CORRESPONDING INSTRUCTIONS BELOW.

13

1. All bidders must attend the MANDATORY pre-bid conference and will be required to sign in and out as evidence of
attendance. In accordance with LSA R.S. 38:2212(]), all prospective bidders shall be present at the beginning of the
MANDATORY pre-bid conference and shall remain in atiendance for the duration of the conference. Any prospective
bidder who fails to attend the conference or remain for the duration shall be prohibited from submitting a bid for the
project.

2. Atlendance fo this pre-bid conference is optional. However, failure to attend the pre-bid conference shall not
relieve the bidder of responsibility for information discussed at the conference. Furthermore, failure to attend
the pre-bid conference and inspection does not relieve the successful bidder from the necessity of furnishing
materials or performing any work that may be required to complete the work in accordance with the specification
with no additional cost to the owner.

3. Contractor must hold current applicable JEFFERSON PARISH licenses with the Department of Inspection and
Code Enforcement. Contractor shall obtain any and all permits required by the JEFFERSON PARISH
Department of Inspection and Code Enforcement. The contractor shall be responsible for the payment of
these permits. All permits must be obtained prior to the start of the project. Contractor must also hold any
and all applicable Federal and State licenses. Contractor shall be responsible for the payment of these permits
and shall obtain them prior to the start of the project.

4. A LA State Contractor's License will be required in accordance with LSA R.S. 37-2150 et. seq. and such license
number will be shown on the outside of the bid envelope. Failure to comply will cause the bid to be rejected,
Additionally if submitting the bid electronically, then the license number must be entered in the appropriate field
in the Electronic Procurement system. Failure to comply will cause the bid to be rejected.

5. ltis the bidder's responsibility to visit the job site and evaluate the job before submitting a bid.

6. Job site must be clean and free of all litter and debris daily and upon completion of the contract.
Passageways must be kept clean and free of material, equipment, and debris at all imes. Flammable material
must be removed from the job site daily because storage will not be permitted on the premises. Precautions
must be exercised at all times to safeguard the welfare of JEFFERSON PARISH and the general public.




DATE:  1M9/2017
BID NO.: 50-00118737 Page: 3
INSTRUCTIONS FOR BIDDERS AND GENERAL CONDITIONS

7. PUBLIC WORKS BIDS: All awards for public works in excess of $5,000.00 will be reduced to a formal
contract which shall be recorded at the contractor's expense with the Clerk of Court and Ex-Officio Recorder of
Mortgages for the Parish of Jefferson. A price list of recordation costs may be obtained from the Clerk of Court
and Ex-Officio Recorder of Mortgages for the Parish of Jefferson. All awards in excess of $25,000.00 will require both a
performance and a payment bond. Unless otherwise stated in the bid specifications, the performance bond requirements shall
be 100% of the contract Brice‘ Unless otherwise state in the bid specifications, the payment bond requirements shall be 100% of
the contract price. Both bonds shall be supplied at the signing of the contract.

8. NON-PUBLIC WORKS BIDS: A performance bond will be required for this bid. The amount of the bond will be
100% of the contract price unless otherwise indicated in the specifications. The performance bond shall be
supplied at the signing of the contract.

9. NON-PUBLIC WORKS BIDS: A payment bond will be required for this bid. The amount of the bond will be
100% of the contract price unless otherwise indicated in the specifications. The payment bond shall be
supplied at the signing of the contract.

10. Unless otherwise stated in the bid specifications, the successful bidder will be required to procure standard insurance policies
evidencing Parish-mandated insurance requirements as indicated on the attached “insurance requirements” sheet. All bidders
must comply with the instructions in this sheet. Failure to comply will cause bid to be rejected.

11. A bid bond will be required with bid submission in the amount of 5% of the total bid, unless otherwise stated in the bid
specifications. Acceptable forms shall be limited to cashier's check, certified check, or surety bid bond. All sureties must be in
original format (no copies). if submitting a bid online, vendors must submit an electronic bid bond through the respective online
clearinghouse bond management system(s) as indicated in the electronic bid solicitation on Central Auction House. No
scanned paper copies of any bid bond will be accepted as part of the electronic bid submission.

12. This is a requirements contract to be provided on an as needed basis. JEFFERSON PARISH makes no
representations on warranties with regard to minimum guaranteed guantities unless otherwise stated in the bid
specifications.

13. Freight charges should be included in total cost when quoting. [f not quoted FOB DELIVERED, freight must be
quoted as a separate item. Bid may be rejected if not quoted FOB DELIVERED or if freight charges are not
indicated on bid form.

14. PUBLIC WORKS BIDS - Completed, Signed and Properly Notarized Affidavits Required; This applies to all solicitations for
construction, alteration or demolition of public buildings or projects, in conformity with the provisions contained in LSA-RS
38:2212.9, LSA-RS 38:2212.10, LSA-RS 38:2224, and Sec 2-923.1 of the Jefferson Parish Code of Ordinances. For bidding

urposes, all bidders must submit with bid submission COMPLETED, SIGNED and PROPERLY NOTARIZED Affidavits, including:

on-Conviction Affidavit, Non-Collusion Affidavit, Campaign Contribution Affidavit, Debt Disclosures Affidavit and E-Verify
Affidavit. For the convenience of vendors, all affidavits have been combined into one form entitted PUBLIC WORKS BID
AFFIDAVIT. This affidavit must be submitted in its original format, and without material alteration, in order to be compliant and for
the bid to be considered responsive. A scanned copy of the completed, signed and properly notarized affidavit may be submitted
with the bid, however, the successful bidder must submit the original affidavit in its original format and without material alteration
upon contract execution. Failure to comply will result in the bid submission being rejected as non-responsive. The Parish reserves
the right to award bid to the next lowest responsive and responsible bidder in this event.

16. NON PUBLIC WORK BIDS - Completed, Signed and Properly Notarized Affidavits Required in conformity with the provisions
contained in LSA — RS 38:2224 and Sec 2-923.1 of the Jefferson Parish Code of Ordinances. For bidding purposes, all bidders
must submit with bid submission COMPLETED, SIGNED and PROPERLY NOTARIZED Affidavits, including: Non-Collusion
Affidavit, Debt Disclosures Affidavit and Campaign Contribution Affidavit. For the convenience of vendors, all affidavits have been
combined into one form entitled NON PUBLIC WORKS BID AFFIDAVIT. This affidavit must be submitted in its original format, and
without material alteration, in order to be compliant and for the bid to be considered responsive. A scanned copy of the completed,
sighed and properly notarized affidavit may be submitted with the bid, however, the successful bidder must submit the original
affidavit in its original format and without material alteration upon contract execution. Failure to comply will result in the bid
submission being rejected as non-responsive. The Parish reserves the right to award bid to the next lowest responsive and
responsible bidder in this event.

16. The ensuing contract for this bid solicitation may be eligible for FEMA reimbursement and/or Fedéral funding/reimbursement. As
such, the referenced appendix will be applicable accordingly and shall be considered a part of the bid documents. All applicable
certifications must be duly completed, signed and submitted with bid submission. Failure to submit applicable cerlifications with
bid submission will result in bid rejection.

It shall be the duty of every parish officer, employee, department, agency, special district, board, and commission: and the
duty of every contractor, subcontractor, and licensee of the parish, and the duty of every applicant for certification of
eligibility for a parish contract or program, to cooperate with the Inspector General in any investigation, audit, inspection,
performance review, or hearing pursuant to Jefferson Parish Code of Ordinances Section 2-155.10(19). By submittinga
bid, vendor acknowledges this and will abide by all provisions of the referenced Jefferson Parish Code of Ordinances.




INVITATION TO BID

DATE:  1/19/2017 THIS IS NOT AN ORDER Page: 4
BID NO.: 50-00118737 JEFFERSON PARISH
PURCHASING DEPARTMENT
P.0. BOX 9

GRETNA, LA. 70054-0009
504-364-2678

VENDOR: 27118 BLANK BID COPY VENDOR  Coburn's BUYER: MOVALLE

As per LSA-RS 47:301 et seq., all governmental bodies are excluded from payment of sales taxes to any Louisiana taxing
body. Quotations shall be based on F.0.B. Agency warehouse or jobsite, anywhere within the Parish as designated by the
Purchasing Department.

JEFFERSON PARISH reserves the right to cancel all or any part of an order if not shipped promptly. No charges will be
allowed for parking or cartage unless specified in quotation. The order must not be filled at a higher price than quoted.
JEFFERSON PARISH reserves the right to cancel at any time and for any reason by issuing a THIRTY (30) day written
notice to the contractor.

JEFFERSON PARISH is expecting all products to be new and all work is to be done in a workman-like manner, according
to standard practices. Any deviations or alterations from the specifications must be indicated and backup documentation
supplied with your quotation.

DELIVERY: FOB JEFFERSON PARISH

INDICATE DELIVERY DATE ON EQUIPMENT AND SUPPLIES 7-14-cays

INDICATE STARTING TIME (IN DAYS) FOR CONSTRUCTION WORK
INDICATE COMPLETION TIME (IN DAYS) FOR CONSTRUCTION WORK

In the event that addenda are issued with this bid, bidders MUST acknowledge all addenda on the bid form. Bidder must
acknowledge receipt of an addendum on the bid form as indicated. Failure to acknowledge any addendum on the bid
form will result in bid rejection.

Acknowledge Receipt of Addenda: NUMBER:
NUMBER:
NUMBER:
NUMBER:

LOUISIANA CONTRACTOR’S LICENSE NO.: (if applicable)

*** ALL BIDDERS MUST COMPLETE SECTION BELOW ***

FIRM NAME:
Coburn's Supply B yo) ) /

SIGNATURE: TITLE:
(Must be signed here) OSR

PRINT OR TYPE NAME:

Michael Self
ADDRESS:
1849 Commercial Drive
CITY, STATE: ZIP:
Harvey, LA 70058
TELEPHONE: FAX:
(225 ) 369-3395 (504 ) 348-1095

EMAIL ADDRESS:

mself@coburns.com

TOTAL PRICE OF ALL BID ITEMS: § $3:268.00




DATE: 1/19/2017

BID NO.: 50-00118737

INVITATION TO BID FROM JEFFERSON PARISH - continued

Page: 5

SEALED BID

ITEM
NUMBER

QUANTITY

u/m

DESCRIPTION OF ARTICLES

UNIT PRICE
QUOTED

TOTALS

2.00

30.00

8.00

12.00

15.00

EA

EA

EA

EA

EA

A ONE-TIME PURCHASE OF PLUMBING HAND
TOOLS, CURB STOP AND VALVE KEYS FOR THE

JEFFERSON PARISH PUBLIC WORKS WAREHOUSE

0010 - SHUT OFF TOOL,
FOR 3/8 IN TO 2 IN, POLYETHELENE TUBING

WHEELER #75

STK # 585210  Quoting Reed #PES2CTS

specs attached

0020 - TOOL, SHUT OFF,
FOR 3/4 IN TO 1IN, POLYETHELENE TUBING

(WATER SERVICE),
REED # PESO-1
STK # 585220

0030 - KEY, CURB STOP, 2 FT, T SHAPED
MADE OF C1018 STEEL, FOR 3/4 INAND 1IN

WATER METERS
STK # 58790

0040 - KEY, VALVE, 6 FT LONG, T HANDLE
TO FIT 2 IN SQUARE NUT, ALLOWS MUD AND

DEBRIS TO EXIT THROUGH HOLES ON TOP OF
SOCKET,

POLLARD # P-545 Quoting Reed #VKA

STK # 58800 specs attached

0050 - CONE (TOOL ONLY), TUBING PULLER
GRICE INDUSTRIES
STK # 59115C

$290.00

$580.00

$58.00

$1,740.00

No Bid

79.00

$948.00

No Bid




1/25/2017 PES2CTS - PE Squeeze-Off Tools - Reed Manufacturing

800.666.3691
Toll Free USA and Canada

PRODUCTS WHERE TO BUY RESOURCES CONTACT REED

PIPE TOOLS & VISES
SINCE 1896

Home » Products » Plastic Pipe Tools » PE Squeeze-Off Tools » PES2CTS

PES2CTS
Product Detail
Catalog No.:  PES2CTS
ltem Code: 04304
 Specifications
Capacity |
in-nom. 1/2-2
~actual 0.D. .63" -2.13"
Pipe/SDR Stops
. # of Stops 6
Stop [1] 98078
Hm:m:d
PES2CTS — also represents PES2IPS, PES2METRIC, and in 12
PES2SDR17 | mm 305
Emmm:n
Ibs 116
kg 5.3
[1] See PE Squeeze-0ff Tool Stops, CTS & IPS or
Metric Stops in "Accessories” for specifications.
FEATURES

» Heavy-duty construction for use on CTS pipe.

https://www.reedmfgco.com/en/products/plastic-pipe-tools/pe-squeeze-off-tools/pes2cts/

12



1/25/2017 VKA - Valve & Curb Keys - Reed Manufacturing

= Wide choice of attachable tools allows users to customize to their systems.
* Made in USA, Reed valve keys feature strong welds at critical points.
» As a safety feature, Reed valve keys bend before they break.

s Use manually with included handle or add Reed's 700PD power drive and clutch for power valve operation.

Valve & Curb Keys Matrix
Get PDF File »
Email PDF File »

https:/ivww.reedmfgco.com/en/products/water-services-tools-and-machines/valve-and-curb-keys/vka/

\meé | Acrobat Reader

2/2



1/25/2017 PES2CTS - PE Squeeze-Off Tools - Reed Manufacturing

» Two-position handle for work location options.

e Change the stops to use tool on other pipe types.

» Fine Thread for smooth squeeze from the operator.

» Grease Fittings at friction points.

» Uses a pair of Rotating Stops to prevent damage to the pipe.
e Swing out arm to easily get tool around the pipe.

» Grounding Accessory and Static Discharge Alarm options.

Manuals

8 oot 08 Horhimriken:
PR Mk

i PR

i e Prort 9
I Whemeimg FYA

e

PES2 Operator's Manual
Get PDF File »
Email PDF File »

Parts

hitps:/Awww.reedmfgco.com/en/products/plastic-pipe-tools/pe-squeeze-off-tools/pes2cts/

: stAdobe
, \w Acrobat Beader
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1/25/2017 VKA - Valve & Curb Keys - Reed Manufacturing

800.666.3691

Toll Free USA and Canada

PRODUCTS RESOURCES CONTACT REED
PiPE TOOLS B VISES
SINCE 1896
Home » Products » Water Services Tools & Machines » Valve & Curb Keys » VKA
VKA

 Product Detail

- Catalog No.: VKA
[tem Code: 02340

- Specifications

e Valve Key for 2" Operating Nut,

Description 5y stable Length
Closed Length
in 45

-mm 1143
Open Length [1]
in [1] . 81
mm [1] . 2057

VKA (top), VK2CK1 (bottom) i

Weight

- Ibs 144
kg 6.5
[1] Open Length represents the key as sold, without

any extra pieces.
FEATURES

» Compact size fits in crowded utility trucks, behind pickup seats, or in car trunks.
* Heavy gauge, mechanical steel tubing shafts support a maximum torque of 200 foot-pounds.
» Reed VK2 or VK3 saves the space, expense, and handling of 1 or 2 other single purpose keys.

https:/iwww.reedmfgco.com/en/products/water-services-tools-and-machines/valve-and-curb-keys/vka/ 12



